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Introduction

Sequence Creation Software SD013-PWX Wavy for PWX is a software application that is used to cre-
ate and execute sequences on PWX Series regulated DC power supplies. This operation guide
explains how to use Sequence Creation Software SD013-PWX Wavy for PWX to control PWX Series
regulated DC power supplies.

 Applicable version 

This operation guide applies to version 6.x of SD013-PWX Wavy for PWX. To find out the version
of the Wavy for PWX, click on the [Help] menu and select [About Wavy].

 Intended readers of this operation guide

This operation guide is intended for users who will use SD013-PWX Wavy for PWX to control DC
power supplies and instructors of such users.

It assumes that the reader has knowledge about electrical aspects of DC power supplies.

 Trademarks

Microsoft and Windows are trademarks of Microsoft Corporation in the United States and/or
other countries.

All other company and product names used in this guide are trademarks or registered trade-
marks of their respective owners.

 Notations used in this guide

• In this guide, SD013-PWX Wavy for PWX is referred to as ”Wavy for PWX“ or “Wavy.”
PWX Series regulated DC Power Supply is referred to as the “PWX Series.”

• The term “PC” means both personal computers and workstations.

• The following markings are used in this guide.

Indicates a potentially hazardous situation which, if ignored, may result in 
damage to the product and other property.

Indicates information that you should know.

CAUTION
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Configuring the Interface

You need to configure the interface before using Wavy.

Using the RS232C interface

1 Ensure that the PC is properly connected to the PWX Series.

2 Confirm that the PWX Series protocols are factory default settings.
By factory default, Baudrate is set to 19200 bps. Data bit length, stop bit length, and Flow (x-flow
control) are fixed to 8 bits, 1 bit, and OFF respectively.

3 Click on the [Setting] menu and select [Interface].
The [Interface] window opens.

4 Select [RS232C].

5 Set the [COM Port].

6 Click [Test] to verify that your PC is properly communicating with the PWX
Series.

7 Click [OK] to close the window.
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Configuring the Interface

Using the USB interface

1 Ensure that the PC is properly connected to the PWX Series.

2 Click on the [Setting] menu and select [Interface].
The [Interface] window opens.

3 Select [USB].

4 Select the connected PWX Series from the [Instrument] drop-down menu. 

5 Enter the serial number of the PWX Series in [Serial Number].
You can confirm the serial number on the rear panel of the PWX Series.

6 Click [Test] to verify that your PC is properly communicating with the PWX
Series.
In case of the communication error, verify that the PWX Series is being recognized on your PC.

In the Control Panel, click [System and Security]. Then, click [Device Manager] under [System].

Verify if “USB Test and Measurement Device” is indicated.

If the device does not appear in the [Device Manager], reinstall it.

7 Click [OK] to close the window.

When the PWX Series suddenly becomes unrecognized

When the PC enters sleep mode, it may stop recognizing the PWX Series. In such a case, disconnect
the USB cable once and reconnect it.
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Configuring the Interface

Using the LAN interface

1 Ensure that the PC is properly connected to the PWX Series.

2 Click on the [Setting] menu and select [Interface].
The [Interface] window opens.

3 Select [Ethernet].

4 Enter the IP address of the PWX Series in [IP Address].
To find out the IP address, refer to the CONFIG settings (CF35 to CF38) on the PWX Series.

For more details, see the PWX Series user’s manual.

5 Click [Test] to verify that your PC is properly communicating with the PWX
Series.

6 Click [OK] to close the window.

When the PWX Series suddenly become unrecognized

When you are not using a fixed IP address, the IP address of the PWX Series may change. If the PWX
Series suddenly become unrecognized, confirm the IP address by checking the CONFIG settings
(CF35 to CF38) on the PWX Series. If the IP address has been changed, re-enter the update IP
address in the [IP Address]. 

Specifying the channel

While the multi channels are active, you can specify the target channel for running the sequence.
Before specifying the channel, you need to verify that the communication has been established
between your PC and the PWX Series via the chosen interface.

To specify the channel, select the applicable channel from [Channel] drop-down menu.
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Screen Overview

Sequence Setup window

When you start Wavy, a main window comprising [Graph] and [Worksheet] windows appears. 

In the [Graph] window, you can set the steps by drawing lines with a mouse.

In the [Worksheet] window, you can set the steps by entering the values.
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Screen Overview

Sequence Execution window

When you execute a sequence, the [Run] window opens.

You can also have the real-time monitor graph displayed in the [Run] window.

Click the tab to show (setting graph or monitor graph) in the window. 

Furthermore, you can have both the setting graph and the monitor graph displayed on a single tab.
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Overview of Sequence Creation

A sequence is a feature that automatically executes the predefined steps in a given order. By com-
bining separate steps into a sequence, you can simulate various waveforms.

A sequence comprises multiple steps, which will be executed in a given order. A single sequence
can comprise up to 1024 steps. The execution of the last step normally concludes the sequence. If
you set the repetition count of a sequence, however, the sequence will be repeatedly executed until
it reaches to the last count. 

Sequence execution procedure

1 Set the operating conditions for the sequence.

2 Set the operating conditions for the steps.

3 Execute the sequence.
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Sequence Settings

Sequence settings

For a sequence, you need to set the following conditions common for all steps.

• Operating mode (Constant Voltage (CV) or Constant Current (CC))

Set the operating mode. The current/voltage limit can also be specified.

• Output-on startup state parameter (CV is prioritized / CC is prioritized)

Set the mode to be prioritized at the output-on startup.

• Repetition count

Set how many times to repeat the sequence.

• Bleeder (ON / OFF)

On/off the bleeder.

• Protection settings

Configure the protection settings.

Step settings

For each step, you need to configure a set of values as shown in the figure below. 
One step corresponds to one operation in a waveform to be executed.

Time [s] indicates the accumulated time from the beginning, which is unable to be modified.

• Voltage (in CV mode)

Set the voltage when Constant Voltage (CV) mode being enabled.

• Current (in CC mode)

Set the current when Constant Current (CC) mode being enabled.

• Interval

Set the execution time for the step.

Risk of malfunction.
This application software does not check the validity of values (if the values exceed the limits of the 
device) while it executes sequences. Do not specify voltages or currents that exceed the specifica-
tions of the regulated DC power supply.

CAUTION
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Sequence Settings

• Transition (Step or Ramp)

Set the transition type for the step.

The resolution of ramp transition is 0.5 seconds (interval unit: seconds) or 1 seconds (interval
unit: minutes or hours).

When the step interval is limited, the ramp line may not be linear.

• Output (on or off )

Switch on/off of the output.

You can edit the steps by either drawing lines in [Graph] window or entering values in [Work-
sheet] window.
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Setting the Operating Mode

Select the operating mode among two modes: constant voltage (CV) or constant current (CC)
mode.

1 Click on the [Sequence] menu and select [Mode]. Or, click  on the toolbar.
The [Mode] window opens.

2 Select [Constant Voltage] to set the sequence in CV mode, or select [Constant
Current] to set it in CC mode.

3 Enter the limited current (for CC mode) or limited voltage (for CV mode).
There are three significant decimal places (x.xxx). The actual number of significant decimal places
varies depending on the PWX Series to which the PC is connected.

4 Select either [CC is prioritized] or [CV is prioritized] under [Output-on startup
state parameter], and click [Set].
Once the [Set] is clicked, the setting will be transmitted to the PWX Series.

5 Select either [On] or [OFF] under [Bleeder on or off], and click [Set].
Once the [Set] is clicked, the setting will be transmitted to the PWX Series.

6 To monitor the protection status during the execution, select [I confirm the
state of the protection function every four seconds] check box.

7 Click [OK] to close the window.
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Setting Protection Functions

You can enable the protection functions by setting one of two protection functions: [Power Supply
Setting] and [Soft Setting].

 Power Supply Setting

These are the protection functions incorporated in PWX Series regulated DC power supply.

You can set overvoltage protection (OVP), overcurrent protection (OCP), the detection time of
over current protection (OCP) activation, undervoltage limit (UVL), and whether or not to limit
voltage/current settings.

 Soft Setting

These are the protection functions which Wavy for PWX activates on the basis of monitored
data.

You can set overvoltage protection (OVP), overcurrent protection (OCP), undervoltage protec-
tion (UVP), and undercurrent protection (UCP).

Using the protection functions on PWX Series (Power Supply Setting)

1 Click on the [Sequence] menu and select [Protection Setup].
The [Protection Setup] window opens.

2 Set the following items for power supply setting.

Item Unit How to set

Overvoltage protection V Enter Overvoltage protection (OVP) value.

Voltage setting limit*1 — Select (On) or deselect (Off ).

Overcurrent protection A Enter Overcurrent protection (OCP) value.

Current setting limit*2 — Select (On) or deselect (Off ).
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Setting Protection Functions

3 Click [Write].
The settings are transmitted to PWX Series and becomes activated.

4 Click [OK] to close the window.

Querying the PWX Series settings

To query and load the present protection settings on the connected PWX Series, click [Read].

Using the protection functions of Wavy (Soft Setting)

When the overvoltage protection or the overcurrent protection being activated, the sequence exe-
cution stops if the monitored values equal or exceed the set values.

When the undervoltage protection or undercurrent protection being activated, the sequence exe-
cution stops if the monitored values fall below the set values.

1 Click on the [Sequence] menu and select [Protection Setup].
The [Protection Setup] window opens.

Detection time of OCP 
activation

ms

Enter the detection time of OCP activation. 
When OCP is off, deselect the check box.
When OCP is on, select the check box and enter a value 
between 100 and 2000 in increments of 100 ms.

Undervoltage Limit V Enter Undervoltage limit (UVL).

*1. Limits the output voltage to a value that does not exceed 95% of the overvoltage protection
setting (OVP trip point) and is not lower than the undervoltage limit setting. This prevents
you from setting inappropriate output voltage while the output is on. (The inappropriate
output voltage may activate the protection function and eventually turn the output off.) For
more details, refer to the PWX Series User’s Manual.

*2. Limits the output current to a value that does not exceed 95% of the overcurrent protection
setting (OCP trip point). This prevents you from setting inappropriate output current while
the output is on. (The inappropriate output current may activate the protection function and
eventually turn the output off.) For more details, refer to the PWX Series User’s Manual.

Item Unit How to set
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Setting Protection Functions

2 Select the protection function to activate.
While the function being selected, you can enter the value in the text box.

3 Enter the values in the text box.
Note that the entered value turns invalid if the corresponding protection function is unchecked.

4 Click [OK] to close the window.

Ignoring the first monitored values

If the unstable values from the initial monitoring is used, the sequence execution may be
aborted due to the protection function. To avoid such a problem, select the [Ignore the first
monitored values] check box, which keeps the protection function from working on the initial
monitored values and have the sequence to be executed regardless of the initially monitored
values.
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Setting the Sequence Repetition Count

Set the repetition count of the sequence.

1 Click on the [Sequence] menu and select [Mode], or click  on the toolbar.
The [Mode] window opens.

2 Set the repetition count (between 1 and 9999).

3 Click [OK] to close the window.
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Creating or Editing Steps by Drawing

This section explains how to create and edit the steps in the [Graph] window.

1 Move the pointer over the Y axis.
The pointer changes to a crosshair, and the current (in CV mode) or the voltage (in CC mode) is
indicated.

2 Drag the pointer to the point where the desired time (on X axis) and the
desired current/voltage (on Y axis) meets. 
The setting is committed when you release the mouse button, and the corresponding values are
automatically entered in the first line of the [Worksheet] window.

You can change the scale of the graph and/or step interval unit.

3 To add the step, move the pointer over the end point of the previous step.
Once the pointer changes to a crosshair, drag the pointer to the desired point.
The setting is committed when you release the mouse button, and the corresponding values are
entered in the following line of the [Worksheet] window.

Repeat the procedure until you complete creating all the steps.
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Creating or Editing Steps by Drawing

Editing the steps by adjusting the drawn lines

Changing the voltage or current setting

1 Double-click the step to edit.

The end point changes to a black square (), which indicates that you can edit the step.

2 Move the pointer over the black square ().
The pointer changes to a pair of vertical arrows.

3 Drag the pointer vertically until it reaches to the desired point.
The setting changes.

Changing the interval (step execution time)
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Creating or Editing Steps by Drawing

1 Double-click the vertical line (step-division line) that lies at the end point of
the step to edit.

The top of the step-division line changes to a black square (), which indicates that you can edit
the step.

2 Move the pointer over the black square().
The pointer changes to a pair of horizontal arrows.

3 Drag the pointer horizontally to the desired point.
The setting changes.

Changing transition (Step or Ramp)

1 Double-click the step to edit.

The top of vertical line (step-division line) changes to a black square (), which indicates that you
can edit the step.

2 Right-click and select [Transition] from the context menu, then point to [Ramp]
or [Step].
The transition of the step changes.

Deleting the steps

1 Double-click the step to delete.

The top of vertical line (step-division line) changes to a black square (), which indicates that you
can edit the step.

2 Right-click and select [Delete].
The step is deleted.
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Creating and Editing Steps by Entering Values

This section explains how to create and edit the steps in the [Worksheet] window.

The first row in the [Worksheet] window represents step 1. Time [s] indicates the accumulated time
from the beginning and cannot be modified.

To edit the voltage, current, and interval, click the applicable cell and enter the value.

To edit the transition and output, double-click the applicable cell, or click the cell and press Enter
key. By default, the [Transition] is set to “Step”, and the [Output] is set to “on”. Once set, the [Transi-
tion] and [Output] settings cannot be deleted. To delete these settings, you need to delete the
whole step.

You can cancel the edit by pressing Esc key in the middle of entering the values.

Start entering data for step 1 and continue for the following steps in order.
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Creating and Editing Steps by Entering Values

Copying and deleting steps

You can delete and copy the steps in the [Worksheet] window.

Also, you can undo the operation once. To undo the last operation, right-click on the [Worksheet]
window and select [Undo].

Inserting a copy of a step

1 Click a cell in the step to copy.
You can click any cell in the step that you are going to copy.

2 Click on the [Worksheet] menu and select [Copy]. Or, right-click on the [Work-
sheet] window and select [Copy] from the context menu.
The step is copied.

3 Specify the destination to paste the copied step by selecting any cell in the
step.
The copied step will be inserted above the selected step.

4 Click on the [Worksheet] menu and select [Paste]. Or, right-click on the [Work-
sheet] window and select [Paste] from the context menu.
The copied step is inserted above the selected step.

Deleting a step

1 Click a cell in the step to delete.
You can click any cell in the step that you are going to delete.

2 Click on the [Worksheet] menu and select [Delete]. Or, right-click on the [Work-
sheet] window and select [Delete] from the context menu.
The step is deleted.

The deleted step is temporarily copied to the clipboard. Thus, if you select [Paste] command right
after deleting the step, the deleted step will be inserted.

Keyboard shortcuts

You can use the keyboard shortcuts to copy, paste, and delete the steps.

To copy the step, press “C” or “Ctrl + C” on the [Worksheet] window. To paste the step, press “V” or
“Ctrl + V”. To delete the step, press “Delete.” To undo the operation, press “Z” or “Ctrl + Z”. A confir-
mation dialog appears to ask whether or not to commit the operation each time you press the key-
board shortcut.
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Changing the Step Interval Unit

You can set the step interval unit to seconds, minutes, or hours.

1 Click on the [Sequence] menu and select [Mode]. Or, click  on the toolbar.

The [Mode] window opens.

2 Select the unit from the [Unit] drop-down menu.

3 Click [OK] to close the window.

Unit Interval setting range

s (seconds) 0.5 s to 999.5 s

min (minutes) 0.1 min to 999.9 min

h (hours) 0.1 h to 999.9 h
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Changing the Setting Graph Scale

You can change the scale on X-axis and Y-axis in the [Graph] window.

Click on the [Graph] menu and select [Scale]. Or, click  on the toolbar. Then, the [Scale] win-
dow opens. You can also right-click on the [Graph] window and select [Scale] to open the window.

If you select the [Maximum Time], [Maximum Value], or [Minimum Value] check box, the auto scal-
ing function is enabled. While the auto scaling function being enabled, the scale is automatically
adjusted when you enter the values to create steps or open a saved file.

When the auto scaling function is disabled, the value beyond the range does not appear in the
graph.

When you are creating steps by drawing, however, the scale is not automatically adjusted. In this
case, click on the [Graph] menu and select [Update Auto Scale] to update the scale.
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Saving and Loading Steps

After creating the sequence data, you can save the data to a file.

Saving files

To newly save the data to a file, click on the [File] menu and select [Save As]. 

To overwrite the file, click on the [File] menu and select [Save], or select  on the toolbar. In
either case, the file will be saved with extension “wvy”.

 Viewing the saved data

You can open the saved file in Notepad.

By default, the data is saved as tab-separated values. You can select comma-separated values in
the [Environment Setup] window.

First row in the data indicates the sequence conditions.

Second and subsequent rows in the data indicate the step conditions.

Loading the file

You can load the saved data.

Click on the [File] menu and select [Open], or click  on the toolbar.

First column
CV Constant voltage mode

CC Constant current mode

Second column N Always “N”

Third column

s seconds

min minutes

h hours

First column Voltage value or current value

Second column Interval Unit is indicated in the first row.

Third column Transition 0: Step, 1:Ramp

Fourth column Output 0:Off, 1:On
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Executing Sequences

Once you complete creating all the steps, you can move on to the sequence execution.

1 Click on the [Sequence] menu and select [Run], or click  on the toolbar.
The [Run] window opens.

2 Click [Run].
The sequence is executed.

To abort the sequence in progress, click [Stop]. 

The green line roughly indicates the position being executed. When the sequence is repeated for
many times or the sequence is rather longer, however, the green line indication may not be sta-
ble. 

During the sequence execution, you cannot use the menus and the toolbar or change the win-
dow size.

You can change the size of [Run] window when the sequence is not in progress.

If you select the [Output OFF when End/Stop] check box, the output will be automatically turned
off when the sequence execution is complete or aborted, or when the protection function is acti-
vated.

If this check box is not selected, you need to turn off the output manually. To turn off the output,
click the [OFF] under the [OUTPUT OFF when End/Stop] check box. While the sequence being in
progress, [OFF] is disabled.
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Executing Sequences

 Specifying the time to execute the sequence

To specify the time to execute the sequence, select the [Execute at the specified time] check box. In
the opened dialog, enter the target time (year, month, day, hour, minute, second) to execute the
sequence.

Information indicated during the sequence execution

 Status indicator

During the sequence execution, one of the following status is indicated in the [Run] window.

Performing a long sequence increases the data to be displayed in the real-time monitor graph. By
setting the maximum data amount, you can reduce the load to PC. Setting the maximum data
amount does not affect the monitored data to be saved.

CC / CV
In constant current (CC) mode, the box next to CC turns to red.
In constant voltage (CV) mode, the box next CV turns to green.

Count Displays the latest count of the sequence repetition.

Step Displays the step being executed at the moment.

Elapsed Time Displays the elapsed time since the sequence execution started.

Voltage/Current
Displays either voltage or current, depending on the monitor settings.
Displaying the output values in the [Run] window

The PWX Series is ready to start.

The sequence is being executed.

The sequence is complete.

The [Stop] button has been clicked.

A communication error has occurred. Verify the interface settings.

(In case of UVP)

A protection function (UVP, OVP, UCP or OCP) has been activated.

A protection function (POWER LIMIT) has been activated.

The PWX Series is standing by until the specified time to execute 
the sequence is reached.
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Displaying Monitors

You can have the monitored values and the monitor graph displayed in the [Run] window. 

Click on the [Sequence] menu and select the [Monitoring Setup], or click  on the toolbar. The

[Monitoring Setup] window opens.

Displaying the output values in the [Run] window

To display the output values in the [Run] window, select [Current] and/or [Voltage] under [Select
Items to be Monitored].
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Displaying Monitors

Displaying the monitor graph

To display the real-time monitor graph, select the [Display the monitor graph] check box under
[Select Items to be Monitored]. 

When the [Display the monitor graph] check box being selected, additional tabs — [Monitor Graph]
and [Setting/Monitor Graph] — are displayed in the [Run] window.

On the [Setting/Monitor Graph] tab, both setting graph and real-time monitor graph are displayed.

You can specify the item (current and/or voltage) to be displayed in the real-time monitor graph.

If you move the pointer over the graph, the monitored value will be displayed.
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Changing the Real-Time Monitor Graph Scale

You can change the scale on X-axis and Y-axis in the real-time monitor graph.

To change the scale, right-click on the real-time monitor graph and select [Scale] from the context
menu. The [Scale] window opens.

If you select the [Maximum time], [Maximum current], [Maximum voltage], or [Minimum Value]
check box, the auto scaling function is enabled. While the auto scaling function being enabled, the
scale is  automatically adjusted according to the monitored values.

When the auto scaling function is disabled, the monitored value beyond the range does not appear
in the graph.

When the maximum time is set to be automatically scaled

When the [Auto] check box of [Max time] is selected, you can specify either [Roll mode] or [Normal
mode].

 Roll mode

The X-axis and Y-axis are simultaneously scaled. The display range is defined by subtracting the
minimum time setting from the maximum time setting.

 Normal mode

In normal mode, the minimum time is fixed to a given value whereas the maximum time is
scaled.

When the [Scrolling within the specified range] check box is selected, the graph is scaled when
the monitored value exceeds the maximum time on the X-axis. In this case, the time range to be
scrolled is defined by subtracting the minimum time setting and the scrolling time from the
maximum time setting.

For example, if the minimum time is set to 0 s, the maximum time is set to 23 s, and the scroll
time is set to 10 seconds, the time range will be 13 s (calculated from 23-0-10).
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Changing the Monitoring Interval

You can set the interval for monitoring.

To change the monitoring interval, click on the [Sequence] menu and select [Monitoring Setup], or

click  on the toolbar. The [Monitoring Setup] window opens.

Under [Select Items to be Monitored], set the [Monitoring Interval] to a value between 100 ms and
600 000 ms.
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Saving Monitored Data

You can save the monitored data in a text format.

To save the monitored data, click on the [Sequence] menu and select the [Monitoring Setup], or

click  on the toolbar. The [Monitoring Setup] window opens.

Select [Yes] under the [Save File], and specify the destination to save the file.

The given file name concatenates the operating mode, the starting date and time of the execution,
and the file extension. You can change the file extension (.txt by default).

You can set the unit of elapsed time to be written to the file. The accuracy of the elapsed time
depends on your PC environment.

[s]: Seconds

[h:min:s]: Hours, minutes, seconds

If you select the [Data right before Run] check box under [for Saved Data], “0 s” will be written to the
beginning of the saved data file (“0 s” would be regarded as the value monitored prior to the
sequence execution). If you select the [Data Immediately after End/Stop] check box, the values
monitored when the sequence is complete/aborted will be written to the end of the saved data file.

Under [Order for output to file], you can set the order in which the monitored data (time, voltage,
and current) is written to the file.

 Viewing the saved data

You can open the saved file in Notepad.

By default, the data is saved as tab-separated values. You can select comma-separated values in
the [Environment Setup] window.
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Other Settings

Setting the resolution of the steps to be created by drawing

You can set the resolution of the steps to be created by drawing in the [Graph] window.

 Setting the resolution of the time interval

Right-click on the [Graph] window and select [Resolution of time period] from the context
menu, then point to the desired resolution ([Default], [1st digit of integer], [1st digit of decimal
place], or [2nd digit of decimal place]). 

 Setting the resolution of the setting value

Right-click on the [Graph] window and select [Resolution of setting value] from the context
menu, then point to the desired resolution ([Default], [1st digit of integer], [1st digit of decimal
place], [2nd digit of decimal place], or [3rd digit of decimal place]). 

Always using the step transition mode when creating the steps 
by drawing

You can restrict the transition mode to “step” when creating the steps by drawing in the [Graph]
window.

Right-click on the [Graph] window, and then select [Draw sequence by step].

Changing the unit of time in the real-time monitor graph

You can change the unit of time ([s] or [h:min:s]) in the real-time monitor graph.

Right-click on the real-time monitor graph and select [X-axis Unit] from the context menu, then
point to the desired unit. Select [s] for seconds, or [h:min:s] for hours:minutes:seconds.
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Setting the maximum data size

Executing a long sequence increases the data displayed on the real-time monitor graph, which
increases the load to PC and causes the PC to malfunction. By setting the maximum data size, you
can reduce the load to PC.

Setting the maximum data size does not affect the monitored data to be saved.

Right-click on the real-time monitor graph and select the [Max Data Count]. The [Maximum number
of data] window opens.

Enter the value between 10 000 to 1000 000. (The default value is 100 000).

When the size of the monitored data exceeds the set value, the oldest data will be deleted and the
data size will be restricted to be within the maximum data size.

A single monitored data uses approximately 200 bytes.

It is recommended to watch the physical memory amount in the Task Manager while executing a
long sequence.

Changing the graph properties

You can change various settings for the setting graph and the real-time monitor graph.

Setting the items (current or/and voltage) to be displayed on the 
monitor graph

You can set the item (current or/and voltage) to be displayed on the real-time monitor graph.

Right-click on the monitor graph and select the [Line Display], then point to the item to be dis-
played.

Showing and hiding the step-division lines

• [Graph] window

To show/hide the step-division lines in the [Graph] window, click on the [Graph] menu and

select [Vertical Axis] or click  on the toolbar. 

Also, you can right-click on the [Graph] window and select [Vertical Axis] to toggle the display
of the lines.

• Setting graph in the [Run] window

To show/hide the step-division lines in the [Run] window, right-click on the setting graph and
select [Vertical Axis]. 

Changing the scale of X-axis and Y-axis 

You can change the settings for X-axis and Y-axis scales. You can show/hide the scales, specify the
line type (solid or dotted) and the number of lines (grid).

 Showing and hiding the scales

• [Graph] window
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To show/hide the scale, click on the [Graph] menu and select either [X-axis Scale Lines] or [Y-axis
Scale Lines], or right-click on the [Graph] window and select [X-axis Scale Lines] or [Y-axis Scale
Lines] from the context menu.

• [Run] window

To show/hide the scale, right-click on the graph in the [Run] window and select the [X-axis Scale
Lines] or [Y-axis Scale Lines] from the context menu.

 Setting the line type (dotted or solid) and the grid

• [Graph] window

Click  on the toolbar. The [Scale] window opens.

To vary the grid, enter the number in [Number of scale lines].

To set the line type to be dotted, select [Dot] check box. When the [Dot] is not selected, the line
will be solid.

• [Run] window

Right-click on the graph in the [Run] window and select [Number of scale lines]. The [Scale
lines] window opens.

To vary the grid, enter the number in [Number of scale lines].

To set the line to be dotted, select [Dot] check box. When the [Dot] is not selected the line will
be solid.

Changing Y-axis value displayed when the pointer is over

When you move the pointer over X-axis or Y-axis on the real-time monitor graph, the monitored val-
ues for X-axis or Y-axis are indicated. 

To change the Y-axis value to be indicated, right-click on the monitor graph and select [Y-Axis
Value], then point to either [Current] or [Voltage].
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Changing the graph color

You can change the color of the setting graph and the real-time monitor graph.

To change the graph color, click the [Graph] menu and select [Color], or right-click on the graphs in
either [Graph] or [Run] window and select [Color] from the context menu. Depending on the item,
the ways to change the color slightly vary.

[Graph] menu 
*1

[Graph] window 
*2

[Run] window:
Setting graph 
*3

[Run] window: 
Monitor graph
*4

Background Background color Yes Yes Yes Yes

Line Setting line Yes Yes Yes —

Line to Draw Line being created Yes Yes — —

Vertical Axis Line being created Yes Yes — —

X/Y-axis X-axis and Y-axis Yes Yes — Yes

XY-axis scale lines Grid lines Yes Yes — Yes

Line to Run
Line indicating the 
sequence point in 
progress

— — Yes —

Current line Output current line — — — Yes

Voltage line
Output voltage 
line

— — — Yes

*1.Click on the [Graph] menu and select [Color].

*2.Right-click on the [Graph] window and select [Color].

*3.Right-click on the [Setting Graph] tab in the [Run] window and select [Color].

*4.Right-click on the [Monitor Graph] tab in the [Run] window and select [Color].
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Changing the sequence data file format

To change the sequence data file format, click on the [Setting] menu and select [Environment
Setup]. The [Environment Setup] menu opens.

Select either [Tab Separation] or [Comma Separation] under [Sequence Data File Format (*.wvy)]. 
By default, [Tab Separation] is selected.

Changing the monitor output data file format 

To change the monitor output data file format, click on the [Setting] menu and select [Environment
Setup]. The [Environment Setup] menu opens.

Select either [Tab Separation] or [Comma Separation] under [Monitor Output Data File Format]. By
default, [Tab Separation] is selected. Also, you can specify the file extension (txt / csv / log). To spec-
ify the file extension, select the desirable extension from the drop-down menu or enter the name.
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Changing the window appearance

To change the appearance of the windows, click on the [Setting] menu and select [Environment
Setup]. The [Environment Setup] window opens.

Select either [New menu style] or [Classic menu style] under [Appearance (after when Wavy is
restarted). As indicated, the selected appearance will be active after Wavy is restarted.

Arranging the [Graph] window and the [Worksheet] window

To arrange the [Graph] window and the [Worksheet] window, click on the [Window] menu and
select [Cascade], [Tile Horizontally], or [Tile Vertically].
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You can use Wavy to remotely control the PWX Series regulated DC power supply.

To remotely control the PWX Series, click on the [Tool] menu and select [Remote Control Panel]. The
[Remote Control Panel] window opens.

You can set the voltage and the current, turn on/off the output, and monitor the status.

Set all the maximum and minimum values in accordance with the connected PWX Series.

 Setting the voltage and current

Enter a value in [Voltage] and click [Set]. Likewise, enter a value in [Current] and click [Set].
These settings are transmitted to the PWX Series. 

If you enter a value in [Step] under [Step Setting], you can adjust the voltage and current by
clicking [Up] or [Down].

 Turning on/off the output

Click [ON] to turn on the output. Click [OFF] to turn off the output. The present status of the
PWX Series will be displayed in the indicator above those buttons.

 Monitor

Click [Run] to start monitoring. Click [Stop] to stop monitoring. The elapsed time is indicated
during monitoring. 

While the monitoring being stopped, you can set the monitor interval.

To save the monitored output data to a file, select [Save File] check box under [Setting]. To spec-
ify the file destination and the unit of the elapsed time written to the file, click [Folder] under
[Setting]. The accuracy of the elapsed time varies depending on your PC environment.

[s]: Seconds

[h:min:s]: Hours, minutes, seconds
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The file name concatenates the operating mode, the start date and time of the execution, and
the file name extension. You can change the file extension (.txt by default).

 GLOBAL command

You can control the voltage, current, and output of all the connected PWX Series units together.

To enable this collective control function, select [I set other PWX connected by LAN by a lump]
check box under [Interface Setting]. 

You can set this item only while the multi channels are active.

 Multi Channel (VMCB)

You can specify a single unit among all the connected PWX Series units and exclusively control
its voltage, current, and output.

To specify the unit being controlled, select the applicable channel in [Channel] under [Interface
Setting].

You can set this item only while the multi channels are active.
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You can transmit the commands to the PWX Series directly from Wavy for PWX.

Click on the [Tool] menu and select [Command Control]. The [Command Control] window opens.

Enter a command and click [Run].

Then, the result will be displayed.

The transmitted commands (successfully transmitted and received commands only) appear as list
items in the drop-down menu. To clear the list items, click [Clear]. 

For details about the commands, see the PWX Series Communication Interface Manual.
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The PWX Series functions as a constant-voltage source or a constant-current source. In constant-
voltage (CV) mode, the PWX Series holds the output voltage to a certain value regardless of the
load change. Whereas in constant-current (CC) mode, the PWX Series holds the output current to a
certain value regardless of the load change. These operating modes are determined by the follow-
ing three factors.

Output voltage setting (Vs)

Output current setting (Is)

Load resistance (RL)

The figure below explains the operating modes.

The load resistance is denoted as “RL”. The resistance, which is calculated from the voltage and cur-
rent settings (RC=Vs/Is), is denoted as “Rc”. The PWX Series is designed to function in CV mode
within A range, and function in CC mode within B range. A and B are divided by the “RL=Rc” bound-
ary line. On this boundary line, the output voltage equals the voltage setting, and the output cur-
rent equals the current setting. When the load resistance RL is greater than the resistance Rc, the
PWX Series operates in CV mode as the operating point (p point) lies within A range. In this case, the
current setting (Is) equals the current limit.

While the PWX Series is operating in CV mode, the output voltage is hold to a certain level. Output
current “I”, on the other hand, is determined by the equation I=Vs/RL and is lower than the current
limit “Is”. The flowing current may not equal the current setting.

For the loads in which transient peak current flows, the current limit “Is” needs to be set higher than
the peak value.

In contrast, when the load resistance RL is lower than the resistance Rc, the PWX Series operates in
CC mode as the operating point (q point) lies within B range. In this case, the voltage setting (Vs)
equals the voltage limit.

While the PWX Series is operating in CC mode, the output current is hold to a certain level. Output
voltage “V”, on the other hand, is determined by the equation V=Is/RL and is lower than the current
limit “Vs”. The flowing voltage may not equal the voltage setting.

For the loads which causes the transient voltage surge, the voltage limit “Vs” needs to be set higher
than the voltage surge.

Crossover point

The operating modes (CV or CC) automatically switches due to the changes in the load. A crossover
point is referred to as the point where the operating mode switches.

For example, if the load changes and the output current reaches to its limit while in CV mode, the
PWX Series switches to operate in CC mode for protecting the load. Likewise, if the output voltage
reaches its limit while in CC mode, the PWX Series switches to operate in CV mode.
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CV/CC modes operation example

The following cases take the PWX Series with rated output voltage 100 V and rated output current
10 A as examples.

First, assume that 8 Ω load resistance (RL) is connected to the output terminals of the PWX Series,
and the output voltage and output current are set to 30 V and 5 A respectively. In this case, the PWX
Series operates in CV mode because RL (8 Ω) is greater than Rc (Rc=30 V/5 A=6 Ω). You can still raise
the voltage up to 40 V (calculated from Vs = ls x RL, that is, Vs = 5 A x 8 Ω = 40 V) in CV mode. If you
attempt to raise the voltage any further, however, the voltage reaches to the crossover point and
the PWX Series automatically switches to operate in CC mode. To allow the PWX Series to continue
operating in CV mode, raise the current limit.

Next, assume that 5 Ω load resistance (RL) is connected to the output terminals of the PWX Series,
and the output voltage and output current are set to 30 V and 5 A respectively. In this case, the PWX
Series operates in CC mode because RL (5 Ω) is lower than Rc (Rc=30 V/5 A=6 Ω). You can still raise
the current up to 6 A (calculated from Is=Vs/RL, that is, Is=30 V/5 Ω=6 A) in CC mode. If you attempt
to raise the current any further, however, the current reaches to the crossover point and the PWX
Series automatically switches to operate in CV mode. To allow the PWX Series to continue operating
in CC mode, raise the voltage limit.
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Menu Description

File (F)

New (N)*1 Creates a new file.

Open (O)...*1 Opens an existing file.

Save (S)...*1 Overwrites the file that you are working on.

Save As (A)... Saves the file with a new name.

Close (D)... Closes the file.

Send (D) Sends the file via e-mail.

Exit (X)
Exits Wavy for PWX. You can save or unsave the 
changes to the file before the exit.

View (V)

Toolbar (T) Shows/hides the toolbar.

Status Bar (S) Shows/hides the status bar.

Save Position (P) Saves the present position and size of the window.

Previous File (F) Loads the last used file.

Graph (G)

Transition (S)
Ramp (L) Changes the transition of the selected line to “ramp”.

Step (S) Changes the transition of the selected line to “step”.

Delete (D) Deletes the selected line.

Vertical Axis 
(V)*1 Shows/hides the vertical axis.

X-axis Scale Lines (X)*1 Shows/hides the X-axis grid

Y-axis Scale Lines (Y)*1 Shows/hides the Y-axis grid

Scale (L)*1 Changes the scale of X-axis and Y-axis.

Color (R)...

Background (B)... Changes the background color of the graph.

Line (L)... Changes the step line color.

Line to Draw (P) Changes the line color being drawn.

Vertical Axis (V) Changes the vertical axis color.

X/Y-axis (A) Changes the color of X-axis and Y-axis.

XY-axis scale 
lines (G)

Changes the color of X-axis and Y-axis grid lines.

Copy (C) Copies the graph to the clipboard.

Update Auto Scale (A) Applies the auto scaling to the graph.

Worksheet (S)

Select All (A) Selects all cells.

Undo (U)*1 Cancels the previous operation.

Delete (D)*1 Deletes the step data.

Copy (C)*1 Copies the step data.

Paste (V)*1 Inserts the copied step data.
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*1 A button with the same function is available on the toolbar.

Sequence (Q)

Run (G)...*1 Executes the sequence.

Mode (M)...*1 Sets the sequence mode and the operating mode.

Monitoring Setup (S)...*1 Configures the monitor settings to be used while the 
sequence being executed.

Protection Setup (N)... Sets OVP, OCP, UVP, and UCP.

Setting (E)

Interface (I)... Configures the interface to connect to the device.

Environment Setup (E)... Sets the file format.

Tool (T)

Remote Control (D)... Controls the connected device directly.

Command Control (C)... Controls the connected device by using commands.

Window (W)

Cascade (C) Cascades the windows.

Tile Vertically (V) Tiles the windows in the vertical direction.

Tile Horizontally (H) Tiles the windows in the horizontal direction.

Arrange Icons (A) Arranges icons along the window frame.

Help (H)

Help Topics (H) Opens the help file.

About Wavy (A)...*1 Displays the application software information includ-
ing the version and the copyright.
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